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About this guide 

Purpose and scope  

This guide helps you get started creating Country of Origin Labelling (CoOL) 
information for your food products with FoodWorks 10 Nutrition Labelling.  

You can use either FoodWorks® Nutrition Labelling Edition or FoodWorks® 
Premium Edition for nutrition labelling. 

 

 

This guide assumes that you already have a basic working knowledge of FoodWorks. To 
learn the basics of nutrition labelling with FoodWorks, refer to the companion guide: 
Introduction to Nutrition Labelling with FoodWorks. 

Note that this guide does not advise you on how to comply with the Australian 
legislative requirements for CoOL. It assumes that you understand the relevant 
legislative requirements for labelling your products, including (but not restricted to): 

• The Country of Origin Food Labelling Information Standard 2016 (under s.134 of 
the Australian Consumer Law - Schedule 2 of the Competition and Consumer Act 
2010). 

• The Australia New Zealand Food Standards Code. 

To meet these requirements, you need to use your own expertise and, where necessary, 
seek legal advice.  

Disclaimer  

Xyris Software disclaims any liability for any loss or injury sustained directly or 
indirectly by any person or organisation as a result of any reliance upon this guide 
and/or the FoodWorks software. You should expertly review any information that you 
gain from FoodWorks, or that you produce using FoodWorks, and seek independent 
legal advice in relation to queries that you have regarding obligations under food 
labelling laws and regulations. 

  

https://support.xyris.com.au/hc/en-us/sections/201019539-Getting-Started-Guides
https://www.legislation.gov.au/Details/F2017C00920
http://www.foodstandards.gov.au/code/Pages/default.aspx
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Getting more help with using FoodWorks  

There are also other ways to get help using FoodWorks, including: 

▪ On-line help 

To get help on using FoodWorks: On the FoodWorks Help menu, click Help Topics.  

• FoodWorks support site 

To search our knowledge base and to submit support requests, please go to the 
FoodWorks support site: support.xyris.com.au 

Contact details  

Telephone:  

+617 3223 5300 or 1800 875 549 

Email:  

info@xyris.com.au 

Web:  

www.xyris.com.au 

support.xyris.com.au 

 

https://support.xyris.com.au/hc/en-us
mailto:info@xyris.com.au
http://www.xyris.com.au/
http://foodworks.zendesk.com/
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1. About CoOL in FoodWorks 

Welcome to FoodWorks 10 Nutrition Labelling with Country of Origin Labelling (CoOL). 

FoodWorks 10 lets you undertake Country of Origin Labelling to comply with the 
requirements under the Country of Origin Food Labelling Information Standard 2016.  

FoodWorks calculates the percentage of Australian ingredients for your recipes, helps 
you formulate your text statements and provides the graphical standard mark.  

Background reading  

For information about how to comply with the CoOL requirements under Australian 
law, see: 

ACCC: A guide for business - Country of Origin food labelling (April 2017) 

®® 

https://www.legislation.gov.au/Details/F2017C00920
https://www.accc.gov.au/publications/country-of-origin-food-labelling
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2. Getting started 

This chapter explains the steps you need to take before you undertake Country of Origin 
Labelling in FoodWorks 10 Nutrition Labelling. 

Setting up your database for CoOL  

If you have created a new database with FoodWorks 10 Nutrition Labelling, your 
database is automatically configured for Country of Origin Labelling.  

If you opened an existing database in FoodWorks 10 (created using an earlier 
version of FoodWorks) that does not yet have CoOL enabled, follow the prompts shown 
to enable CoOL (and other new features you may wish to use):  

If you choose Yes to update, then your database is automatically configured for Country 
of Origin Labelling. 

If you clicked No, then at any time you can follow the steps below to enable CoOL. 

Enabling CoOL for your database  

If you have upgraded to FoodWorks 10 Nutrition Labelling and not yet enabled CoOL, 
here’s how. 

Step 1 –  Enable the CoOL components  

To enable the CoOL components for your database: 

1. On the File menu, click Database Properties. 

2. Click Nutrients & Components. 

3. On the left, click Country of Origin. 
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4. On the right, under Country of Origin, select Australia (%) and Reconstitution 
Factor. 

 

5. Click OK. 

Step 2 –  Enable the CoOL statement on preview label s 

To enable the CoOL statement on your preview labels in this database: 

1. Open the Label window: On the FoodWorks toolbar, click the Label button. 

 

2. At the bottom of the Label window, click the Label Options button. 

 

3. On the left, click Country of Origin. Then select the Show Country of Origin check 
box. 

  

Note that the advanced options shown on this tab are discussed in Setting advanced 
options for CoOL on page 17.  

Next step  

Next you will need to set up your raw materials with CoOL values, particularly their 
percentage of Australian content. See Setting up your raw materials on page 6. 
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3. Setting up your raw materials 

The key to undertaking Country of Origin Labelling in FoodWorks 10 Nutrition labelling 
is setting up your raw materials.  

For FoodWorks to calculate the percentage of Australian content for your recipes, you 
need to set values for the percentage of Australian content for each raw material. Where 
the raw material is reconstituted, you also need to set a reconstitution factor. 

There are two ways to set these values for raw materials: 

• Open each individual raw material and set the values in the Nutrients & 
Components tab. 

• Use the CoOL Editor to set the values for all your raw materials at once. 

Set the CoOL components for a raw material  

To set the CoOL components for an individual raw material: 

1. In FoodWorks, open the raw material. 

2. Click the Nutrients & Components tab. 

3. In the Override column, enter a value for the CoOL components. 

 

The CoOL components for a raw material are: 

• Australia (%) – The percentage of the raw material that is of Australian origin 
as defined in the legislation.  

• Reconstitution factor – This component only applies to raw materials that will 
be treated as reconstituted, as per the legislation (for example, fruit juice 
concentrates). 

A reconstitution factor of 2, means 2 parts of water to 1 part of concentrate. A 
reconstitution factor of 5 means 5 parts of water to 1 part of concentrate. 

If the raw material will not be reconstituted, you can leave this field blank. 
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Use the CoOL Editor for multiple raw materials  

To make it easier to enter or edit the CoOL components for your raw materials, the 
CoOL Editor shows all the raw materials in your database in one table: 

 

To use the CoOL Editor: 

1. On the Tools menu, click CoOL Editor. 

2. Enter the values for Australia(%) as required.  

Note that you can use keyboard shortcuts to make it quicker to enter the percentage 
of Australian content: 

• For 100%, type a. 

• For 0%, type z. 

3. Enter RF (Reconstitution Factor) for raw materials that will be reconstituted. 



GETTING STARTED WITH COOL IN FOODWORKS® 9 NL 8 

4. Reviewing the percent Australian  

FoodWorks calculates the percentage of Australian content for each of your recipes 
using the percentage of Australian content for its raw materials. (For how to set the 
CoOL values for each raw material, see Setting up your raw materials on page 6).  

You can review the final percentage for a recipe in the Analysis Pane. If you need to dive 
deeper to examine how the final percentage was calculated, use the CoOL Explorer. 

Review the percent Australian for a recipe  

To review the percentage of Australian content for a recipe: 

1. Open the recipe.  

2. In the Analysis Pane you can see the percentage of Australian content for the recipe: 

 

 

NOTE: If the Analysis Pane is not already displayed, on the FoodWorks toolbar, click 
the View Analyses button: 

 

 

  

Percentage of Australian 

content. 
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Use the CoOL Explorer  

Use the CoOL Explorer to explore in depth the value for the percentage of Australian 
content calculated for a recipe. With the CoOL Explorer you can examine the CoOL 
values for all the recipe’s nested raw materials and sub-recipes. 

1. Open the recipe that you want to examine. 

2. On the View menu, click CoOL Explorer. 

Here is the CoOL Explorer showing some sample data. 

 

The CoOL Explorer lets you see at a glance all the raw materials and sub-recipes 
contained in the recipe in a nested view. For each raw material and sub-recipe, you 
can view the percent Australian and, if any is set, the reconstitution factor. 

The columns are as follows: 

• Weight: The final weight of the recipe. 

• Aus%: Percentage of Australian content. 

• AusInWt: Australian ingoing weight. 

• ImpInWt: Imported ingoing weight. 

• RF: Reconstitution Factor. 

• RecAusWater: Reconstituted Australian water – The water that needs to be 
assigned to Australia for a reconstituted Australian ingredient. 

• RecImpWater: Reconstituted imported water –  The water that needs to be 
assigned to imported for a reconstituted imported ingredient. 

• ImpWater: Imported water –  Added imported water. 

• AusWater: Australian water – Added Australian water. 

For an explanation of how percentage Australian is calculated for your recipes in 
FoodWorks, see A: Calculations of Australian content on page 22.  
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5. Creating a CoOL statement 

Country of Origin Labelling requirements for individual food items vary depending on 
whether the food is a ‘priority’ or ‘non-priority’ food, and whether it was grown, 
produced, made or packed in Australia or another country, as defined in the legislation. 
For more information, refer to ACCC: A guide for business - Country of Origin food 
labelling (April 2017). 

Step 1 – Create a basic CoOL statement  

To set the CoOL statement for the recipe, in your open recipe: 

1. On the FoodWorks toolbar, click the Label button.  

 

2. In the Label window, click the CoOL tab. 

 

3. Type in the Country of Origin, for example, Australia, or select from the drop-down 
list.  

https://www.accc.gov.au/publications/country-of-origin-food-labelling
https://www.accc.gov.au/publications/country-of-origin-food-labelling
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4. Choose the Statement Type from the drop-down menu, for example, Made In.  

 

5. Set whether this is a Priority food or Non-Priority food (as defined by the Country 
of Origin Food Labelling Information Standard 2016): 

• If this is a Priority food, there is nothing more to do. (Standard marks will be 
shown.) 

• If this is a Non-Priority food, choose whether to show standard marks. Note that 
the option to show standard marks will only be shown if applicable. 

6. Preview the CoOL statement in the preview label.  

 

 

NOTE: If your recipe was created in an earlier version of FoodWorks, then a legacy 
Country of Origin statement may be shown in your label. To change the statement 
type to comply with the requirements, use the above steps. 

The CoOL statement. 

https://www.legislation.gov.au/Details/F2017C00920
https://www.legislation.gov.au/Details/F2017C00920
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Step 2 – Fine-tune your CoOL statements 

For each recipe, you can also choose to: 

• Highlight a particular ingredient(s) 

• Use an ‘ingredient sources vary’ phrase 

Add a highlighted ingredient  

To set a phrase to highlight an ingredient for a recipe: 

1. In the Label window, click the CoOL tab.  

2. In the Highlighted Ingredient(s) Phrase box, enter the name of the highlighted 
ingredient (for example, Australian Olive Oil):  

 

 

The CoOL 

statement 

showing the 

highlighted 

ingredient. 
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Set the text statement for varying Australian content  

To use the ‘ingredient sources vary’ phrase: 

1. In the Label window, click the CoOL tab.  

2. Select Use ‘ingredient sources vary’ phrase. 

 

NEXT STEP  If you use the ‘ingredient sources vary’ phrase, the standard requires 
that you include a way for your customers to find out more information. To add 
this information, see Step 4 – Set where to find additional information on page 19. 
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Set the orientation of the Country of Origin Label  

You can choose whether your Country of Origin label is shown as portrait or landscape 
as in the illustration below: 

 

To set the orientation: 

1. In the Label window, click the CoOL tab.  

2. Under CoOL Label Orientation, select Landscape or Portrait. 

  

Portrait 

Landscape 
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Now your label is ready: Next steps…  

Now that you have your label ready, here are the options for printing or publishing this 
individual label:  

The Toolbar in the Label Window – print or publish the label: 

 

 

 

 

 
 
 
 
 
 
 

NOTE: Publishing all your labels   
You can also publish all the labelling information from your FoodWorks database 
to Microsoft Access or to a tab-delimited text file ready for use by your label-
printing software. See the complementary guide, Introduction to Nutrition 
Labelling with FoodWorks. 

Print the label  

A. To prepare (to set the page size, page orientation etc) to print the label directly to 
your standard printer, click the Page Setup icon: 

1. On the toolbar of the Label window, click the Page Setup icon. 

 

2. Set properties as required. 

3. Click OK. 

 

Page 

setup 

for 

printing. 

Open 

the label 

in MS 

Word. 

Open 

the label 

as a 

PDF. 

Print 

this 

label. 

NOTE; If you use Copy 

to clipboard the 

graphical standard 

mark is not included. 

NOTE; If you use the 

Publish to Excel option 

the graphical standard 

mark  is not included. 

https://support.xyris.com.au/hc/en-us/sections/201019539-Getting-Started-Guides
https://support.xyris.com.au/hc/en-us/sections/201019539-Getting-Started-Guides
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B. To print the label directly to your standard printer: 

1. On the toolbar of the Label window, click the Print icon. 

 

2. Click OK. 

 

Open the label in Microsoft Word  

To open the label for editing in Microsoft Word: 

1. On the toolbar of the Label window, click the Publish to Word icon. 

 

The label will be opened in Word. Note that some formatting information may be lost in 
the conversion from PDF to Word format. 

 

Open the label as a PDF  

To open the label as a PDF document: 

1. On the toolbar of the Label window, click the Open as PDF icon. 
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6. Setting advanced options for CoOL 

You can control aspects of the content and look of your label in the Label Options 
dialog.  

NOTE: All options set through the Label Options dialog apply to all the labels 
generated in your FoodWorks database. 

Set advanced options  

To set advanced options for CoOL: 

Step 1 –  Open the Label Options window  

To set the way percentages are shown in CoOL text statements on your labels: 

1. On the FoodWorks toolbar, click the Label button.  

 

2. At the bottom of the Label window, click the Label Options button.  

 

3. On the left, click Country of Origin.  
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Step 2 –  Set the way percentages are shown  in text statements  

The checkboxes shown are the options for how to show percentages in your text 
statements.  

Select checkboxes as required.   

 

 

The following table explains the options for expressing percent Australian: 

 

Option Meaning Selected  Not selected  

Omit ‘100%’ when 100% 
Australian ingredients 

Select this option to omit the 
‘100%’ text when the final 
recipe contains 100% 
Australian ingredients. 

Made in Australia from 
Australian ingredients 

Made in Australia from 
100% Australian 
ingredients 

Use ‘imported’ when 0% 
Australian ingredients 

Select this option to use the 
term ‘imported’ rather than 
0% Australian.  

Made in Australia from 
imported ingredients  

Made in Australia from 
0% Australian 
ingredients 

Use ‘less than’ when 
Australian ingredients 
<10% 

Select this option to use the 
‘less than’ phrase. 

Made in Australia from 
less than 10% 
Australian ingredients  

Made in Australia from 
at least 3% Australian 
ingredients 

Options for expressing 

percent Australian in 

your text statements. 

See the following table. 
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Step 3 –  For non-priority foods, set whether a box is shown  

Select this option to surround the CoOL text statement for non-priority foods with a box. 

 

 

Step 4 –  Set where to find additional information  

Additional information is required when the ‘ingredient sources vary’ phrase is 
used. This text should advise your customers on how to find more information about 
the product, for example, via a telephone number or a website address.  

Example: Visit www.ripperdips.com.au for details.  

In the Additional Information box, enter the appropriate text.  

 

Option to surround the 

text statement with a 

border for non-priority 

foods. 
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7. Publishing your CoOL information 

When you publish your labelling data (using Publish Labelling Information on the 
Tools menu), FoodWorks includes information to support CoOL.  

The CoOL columns published are:  

• CountryOfOrigin: The country of origin as declared for this product, usually 
Australia. 

• CountryOfOriginStatementType: The statement type from the current legislation, 
or legacy statements. 

 

 

 

 

 

 

 

 

 

 

 

 

• CountryOfOriginStatement: The CoOL statement as generated by FoodWorks.  

• CoOLAustralianPercent: The percent Australian rounded down to a whole 
number.  

• CoOLAustralianPercentForBarChart: The percent Australian as used on the bar 
chart is shown in increments of 10, rounding down, with these exceptions:  

o If between 1 and 9%, the bar chart shows 5%. 

o If greater than or equal to 95% and less than 100%, the bar chart shows 95%. 

  

 
 

CoOL Statement Type 
 

Code shown 

CURRENT  
 Unknown 0 

Made In 10 

Grown In 11 

Product Of 12 

Packed In 13 

LEGACY  
 Made In 1 

Made In From Local and Imported 2 

Made In from Imported and Local 3 

Packaged In 4 

Packaged In For Local and Imported 5 

Packaged In From Imported and Local 6 

Grown In 7 

Product Of 8 
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• CoOLStandardMarks: 

 

 

 

 

 

• CoOLStandardMarksImage: This value corresponds to the standard mark image 
name in the Assets folder of the FoodWorks®-BarTender® resources. You can 
download the FoodWorks-BarTender resources here on the FoodWorks support 
site.  

• Orientation:  

 

 

 

• CoOLWarningMessage 

• IsCoOLWarning 

• IsCoOLError 

• CoOLErrorMessage 

 

Getting the CoOL standard mark images into BarTender  

If you are publishing your labelling information from FoodWorks for use in the BarTender® 
Label Software, we provide a solution that enables you to include the standard mark 
images. 

You can find more information here on the FoodWorks support site. 

 

Option Code Shown 

None 4 

Border only 3 

Bar Chart 2 

Kangaroo Logo and Bar Chart 1 

Option Code Shown 

Landscape 0 

Portrait 1 

https://support.xyris.com.au/hc/en-us/articles/360000100616-Tutorial-FoodWorks-and-BarTender-
https://support.xyris.com.au/hc/en-us/articles/360000100616-Tutorial-FoodWorks-and-BarTender-
https://support.xyris.com.au/hc/en-us/articles/360000100616-Tutorial-FoodWorks-and-BarTender-
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A: Calculations of Australian content  

This appendix outlines how FoodWorks calculates the percentage of Australian content 
for a recipe. For examples of these calculations, see ACCC: A guide for business - Country 
of Origin food labelling (April 2017) pages 14-17. 

Basic calculations  

FoodWorks uses the Australian ingoing weight (AusInWt) and imported ingoing weight 
(ImpInWt) to calculate the Australian percentage. 

The basic formula for a final recipe, when there are no reconstituted ingredients, is: 

AusInWt / (AusInWt + ImpInWt) x 100 

For each raw material the AusInWt and the ImpInWt are assigned based on the 
percentage Australian of that raw material. Once assigned, the AusInWt and the 
ImpInWt are simply summed for each final recipe and sub-recipe. 

Raw materials with a declaration type of processing aid or inedible component are 
excluded from the above calculation. 

The ingoing weight is not affected by changes in water content. 

Reconstitution factor  

If you set an ingredient as reconstituted for the purposes of the CoOL calculations using 
a Reconstitution Factor, then the Australian percentage calculation will reflect this. 

To do this, as well as using the AusInWt and the ImpInWt, FoodWorks tracks the 
following: 

• Reconstituted Australian water (RecAusWater): The water that needs to be 
assigned to Australia for a reconstituted Australian ingredient. 

• Reconstituted imported water (RecImpWater): The water that needs to be 
assigned to imported for a reconstituted imported ingredient. 

• Australian water (AusWater): Added Australian water. 

• Imported water (ImpWater): Added imported water. 

The final calculation for the Australian percentage uses these values to adjust the 
AusInWt and the ImpInWt, and these adjusted values are then used to calculate the 
final percentage Australian. 

This approach means that it does not matter in which sub-recipe(s) the reconstituted 
ingredient is used, and the added waters. The Australian percentage calculation 
happens at the final recipe level. 

 

https://www.accc.gov.au/publications/country-of-origin-food-labelling
https://www.accc.gov.au/publications/country-of-origin-food-labelling

